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Utiliser LibreOffice sur un Mac

Sur Mac, certaines touches et certains éléments de menu sont différents de ceux utilisés sous 
Windows ou Linux. Le tableau ci-dessous donne quelques substitutions courantes pour les instruc-
tions de ce chapitre. Pour une liste plus détaillée, voyez l’Aide de l’application.

Windows ou Linux Équivalent Mac Effet

Sélection du menu 
Outils > Options

LibreOffice > Préférences Accès aux options de configuration

Clic droit
Control+clic ou clic droit 
selon la configuration de l’ordinateur

Ouvre un menu contextuel

Ctrl (Control) ⌘ (Command) Utilisé avec d’autres touches

F5 Shift+⌘+F5 Ouvre le navigateur

F11 ⌘+T
Ouvre l’onglet Styles et Formatage 
du volet latéral

La documentation française de LibreOffice est disponible à
https://wiki.documentfoundation.org/Documentation/Publications/fr
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Introduction

Ce chapitre examine les outils et les fonctions qui vont vous permettre de modifier des dessins 
existants. Toutes les fonctions s’appliquent à l’objet sélectionné ou au groupe d’objets sélection-
nés, qui peuvent être distingués par les poignées de sélection sur un cadre rectangulaire suffisam-
ment large pour contenir l’objet. Lorsque plusieurs objets sont sélectionnés, le cadre correspond 
au plus petit rectangle qui peut contenir tous ces objets. Ce cadre est appelé rectangle de sélec-
tion.

Remarque

La forme et la couleur des poignées de sélection peuvent changer selon le type d’objet, ainsi
que l’outil et la fonction qui ont été sélectionnés pour en modifier les propriétés. La couleur 
des poignées de sélection dépend également du système d’exploitation et des paramé-
trages de l’ordinateur.

Sélectionner des objets

Sélection directe

La façon la plus simple de sélectionner un objet est de cliquer directement sur lui. Pour sélection-
ner un objet sans remplissage, cliquez sur sa bordure. Cliquez ailleurs dans le document pour dés-
électionner l’objet. Pour sélectionner plusieurs objets, gardez appuyée la touche Maj pendant que 
vous cliquez successivement sur chacun d’eux.

Sélection par encadrement

Vous pouvez également sélectionner plusieurs objets en cliquant et faisant glisser la souris autour 
d’eux. Un rectangle en pointillés se dessine et seuls les objets qui sont entièrement compris dans 
ce rectangle seront sélectionnés.

Pour sélectionner plusieurs objets par encadrement, l’icône Sélectionner  de la barre d’outils 
Dessin doit être active.

Sélectionner des objets cachés

Si des objets sont cachés derrière d’autres objets et ne sont donc pas visibles, vous pouvez quand
même les sélectionner. Quand vous sélectionnez un objet caché, ses poignées de sélection appa-
raissent à travers les objets qui le recouvrent.

• Système d’exploitation Windows ou Mac : sélectionnez l’objet devant les objets cachés, 
puis cliquez sur l’objet caché à sélectionner en maintenant appuyée la touche Alt. S’il y a 
plusieurs niveaux d’objets cachés, gardez appuyée la touche Alt et cliquez jusqu’à ce que 
vous atteigniez l’objet que vous désirez. Pour parcourir les objets empilés dans l’ordre in-
verse, gardez appuyées les touches Maj+Alt et cliquez.

Lorsque vous cliquez sur l’objet caché, son contour apparaît brièvement à travers l’objet qui 
le recouvre.

• Système d’exploitation Linux : Appuyez sur la touche Tabulation pour parcourir le cycle
des objets existants et de vous arrêter sur l’objet que vous voulez sélectionner. Pour parcou-
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rir le cycle dans l’ordre inverse, appuyez sur Maj+Tab. Cette méthode permet d’atteindre 
très rapidement un objet, mais elle peut ne pas être pratique si le dessin comporte de nom-
breux objets. Elle fonctionne aussi sous Windows et Mac.

Disposer les objets

Dans un dessin complexe, plusieurs objets peuvent être empilés les uns sur les autres. Pour modi-
fier l’ordre de l’empilement en déplaçant les objets vers l’avant ou vers l’arrière, sélectionnez un 
objet et choisissez une des méthodes suivantes :

• sélectionnez Disposition dans le menu contextuel ou dans l’entrée Forme de la barre de 
menus et choisissez l’une des actions disponibles,

• utilisez un des raccourcis clavier indiqués ci-dessous,

• cliquez sur une des icônes

– de la palette accessible à partir de l’icône Disposer  de la barre d’outils Standard ou 
de la barre d’outils Position (Figure 1 en haut) obtenue en détachant la palette ;

– à gauche de la barre d’outils Ligne et remplissage (Figure 1 en bas)  ;

– du panneau Position et taille de l’onglet Propriétés du volet latéral (Figure 13, page 11).

Figure 1 : La barre d’outils Position (en haut)
et la partie gauche de la barre d’outils Ligne et remplissage (en bas)

Actions / Entrées de menu Raccourcis clavier Icônes

Envoyer à l’avant Ctrl+Maj++

Envoyer vers l’avant Ctrl++

Envoyer vers l’arrière Ctrl+-

Envoyer à l’arrière Ctrl+Maj+-

Devant l’objet

Derrière l’objet

Inverser

Positionner et ajuster les objets

Utiliser le zoom

Pour vous aider à positionner et modifier les objets, Draw dispose d’une fonction zoom qui réduit 
ou élargit l’affichage à l’écran du document en cours. Vous pouvez par exemple augmenter le fac-
teur de zoom pour positionner très précisément un objet dans votre document ; puis réduire ce fac-
teur pour voir la page complète. Vous pouvez agir rapidement sur le facteur de zoom en gardant 
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appuyée la touche Ctrl et en utilisant la molette de votre souris. Vous pouvez contrôler plus pré-
cisément le zoom de trois façons différentes : en utilisant la barre d’état, la boîte de dialogue Zoom
& disposition des pages ou la barre d’outils Zoom.

Remarque

Le zoom est traité différemment entre les systèmes d’exploitation Windows et Linux. Un do-
cument enregistré avec un facteur de zoom 100 % dans Windows peut être affiché avec un 
plus grand facteur de zoom dans Linux.

Barre d’état

Les zones de contrôle du zoom s’affichent à l’extrémité droite de la barre d’état (Figure 2). Elles 
vous permettent un accès rapide et facile au zoom.

Diminuer le zoom Augmenter le zoom

Curseur de zoom

Adapter la
diapo à la
fenêtre active

Facteur de zoom
Figure 2 : Les contrôles de zoom dans la barre d’état

• Cliquez sur l’icône Adapter la diapo à la fenêtre active ( ) pour que la page occupe tout 
l’espace de travail de la fenêtre active.

• Cliquez sur le signe – pour réduire le facteur de zoom.

• Cliquez sur le signe + pour augmenter le facteur de zoom.

• Cliquez et faites glisser le curseur pour réduire ou augmenter le facteur de zoom.

• Faites un clic droit sur la valeur du pourcentage de zoom et choisissez l’un des facteurs de 
zoom prédéfinis disponibles dans le menu contextuel.

• Sélectionnez Affichage > Zoom > Zoom ou faite un double-clic sur la valeur du pourcen-
tage de zoom et choisissez un facteur de zoom dans la boîte de dialogue Zoom & disposition
des pages qui s’ouvre (Figure 3).

Boîte de dialogue Zoom & disposition des pages

Figure 3 : La boîte de dialogue Zoom & disposition des pages

La boîte de dialogue Zoom & disposition des pages (Figure 3) offre les options suivantes pour 
contrôler la façon dont votre dessin est affiché sur votre écran :
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Facteur de zoom
Cette section permet de définir le facteur de zoom avec lequel le document est affiché et 
tous les documents du même type que vous ouvrirez par la suite.

– Optimal : le facteur de zoom est le plus élevé qui permet à tous les objets de la page 
d’être entièrement affichés à l’écran.

– Adapter la largeur et la hauteur : la page entière est affichée à l’écran.

– Adapter à la largeur : la page est affichée afin que toute sa largeur soit visible à l’écran. 
Le haut et le bas de la page peuvent ne pas être visibles.

– 100 % :la page est affichée à sa taille réelle.

– Variable : vous permet de saisir le pourcentage de facteur de zoom dans le champ corres-
pondant.

Disposition des pages
Pour les documents texte uniquement (cette section n’est pas accessible sous Draw), vous 
pouvez paramétrer l’aperçu de la mise en page. Réduisez le facteur de zoom pour voir les 
effets des différents paramètres d’aperçu de la mise en page.

– Automatique : l’aperçu automatique de la mise en page affiche les pages côte à côte, 
avec autant de pages que le facteur de zoom le permet.

– Une page : la disposition des pages sur une seule page affiche les pages les unes au-
dessous des autres, mais jamais côte à côte.

– Colonnes : dans la disposition en colonnes des pages, vous voyez les pages dans un 
nombre donné de colonnes côte à côte. Saisissez le nombre de colonnes.

– Mode livre : dans la disposition des pages en mode livre, vous voyez deux pages côte à 
côte comme pour un livre ouvert. La première page est une page de droite avec un numé-
ro de page impair.

Barre d’outils Zoom

Sélectionnez Affichage > Barres d’outils > Zoom pour afficher la barre d’outils Zoom (Figure 4). 
Certains outils ne sont pas affichés par défaut.

Agrandir le zoom Réduire le zoom 100 % Zoom précédent1

Zoom suivant1 Page entière Largeur de page Affichage optimal

Zoom sur les objets Zoom et panoramique Déplacer

Figure 4 : La barre d’outils Zoom

Les outils disponibles sont les suivants :

• Agrandir le zoom : double le facteur de zoom.

• Réduire le zoom : divise par deux le facteur de zoom.

1 Non affiché par défaut.
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• Zoom 100 % : affiche la page à sa taille réelle.

• Zoom précédent1 : revient à l’affichage avec le précédent facteur de zoom appliqué. Vous 
pouvez également utiliser le raccourci clavier Ctrl+, (virgule).

• Zoom suivant1 : annule l’action de la commande Zoom précédent.

• Page entière : affiche la page entière à l’écran.

• Largeur de page : affiche la page afin que toute sa largeur soit visible à l’écran. Le haut et le
bas de la page peuvent ne pas être affichés.

• Optimal : choisit le facteur de zoom le plus élevé avec lequel tous les objets de la page 
puissent être entièrement affichés à l’écran.

• Zoom sur les objets : choisit le facteur de zoom le plus élevé avec lequel le ou les objets 
sélectionnés puissent être entièrement affichés à l’écran.

• Zoom et panoramique : double le facteur de zoom à chaque clic. Vous pouvez également 
cliquer sur l’icône puis cliquer et faire glisser le pointeur de la souris dans la page pour dessi-
ner un cadre rectangulaire qui représente la zone qui sera affichée à l’écran. Ctrl+clic di-
vise le facteur de zoom par deux. Maj+clic-tirer permet de déplacer la page dans la 
zone de travail.

• Déplacer : déplace le document dans l’espace de travail sans modifier le facteur de zoom. 
Cliquez et faites glisser le pointeur de la souris sur le document.

Déplacer et ajuster la taille d’un objet

Lorsque vous déplacez ou modifiez la taille d’un objet, observez la barre d’état en bas de la fenêtre
de Draw (Figure 5). Le deuxième champ indique le type d’objet sélectionné et le quatrième, sa po-
sition dans le dessin en coordonnées X/Y et ses dimensions. L’unité de mesure est celle sélection-
née dans le menu dans la page LibreOffice Draw – Général de la boîte de dialogue Options (Ou-
tils > Options).

Opération en cours

Coordonnées du coin supérieur gauche

Dimensions

Figure 5 : Extrémité gauche de la barre d’état quand un objet est sélectionné

Déplacer des objets

Avec la souris

Pour déplacer un objet (ou un groupe d’objets), sélectionnez-le et positionnez le pointeur de la 
souris au-dessus pour qu’il prenne la forme du curseur de déplacement (habituellement la qua-
druple flèche) ; puis cliquez et faites glisser jusqu’à la position désirée en maintenant l’appui sur le 
bouton gauche de la souris. Durant le déplacement, une image fantôme de l’objet apparaît pour ai-
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der à son positionnement (Figure 6). Relâchez le bouton de la souris pour attribuer son nouvel em-
placement à l’objet.

Figure 6 : Déplacer un objet avec la souris

Avec les touches de direction

Dès lors qu’un objet (ou un groupe d’objets) est sélectionné, vous pouvez le déplacer à l’aide des 
touches de direction (flèches Haut, Bas, Gauche, Droite). Ce positionnement est en général 
plus précis qu’avec la souris. La précision est encore accrue en gardant appuyée la touche Alt 
lors du déplacement. Inversement, l’amplitude du déplacement est augmentée si vous maintenez 
l’appui sur la touche Maj lors du déplacement.

Avec la boîte de dialogue ou l’onglet Position et taille du volet latéral

Voir « Position et taille », page 11 .

Modifier la taille des objets

Avec la souris

Pour modifier la taille de l’objet sélectionné (ou du groupe d’objets sélectionnés), déplacez le poin-
teur de la souris au-dessus d’une des poignées de sélection. Il change de forme pour vous indi-
quer la direction du mouvement correspondant. Cliquez et faites glisser, en maintenant l’appui sur 
le bouton de la souris, jusqu’à atteindre la taille désirée. Au fur et à mesure du changement de 
taille, une image fantôme du nouvel objet apparaît pour vous aider (Figure 7). Relâchez le bouton 
une fois la taille souhaitée atteinte.

Figure 7 : Modifier la taille d’un objet
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Le résultat dépend de la poignée de sélection choisie. Utilisez une poignée au milieu d’un côté 
pour redimensionner un objet selon un seul axe. Utilisez une poignée de coin pour le redimension-
ner selon les deux axes.

Remarque

Si vous gardez appuyée la touche Maj durant le redimensionnement d’un objet, la propor-
tion entre hauteur et largeur sera conservée, afin que le rapport d’aspect de l’objet reste in-
changé. Ce comportement s’applique à toutes les poignées.

Ceci est le comportement par défaut de la touche Maj. Cependant, si l’option Lors de la 
création ou du déplacement des objets de la section Contraindre les objets est cochée 
dans la page LibreOffice Draw – Grille de la boîte de dialogue Options (Outils > Options 
dans la barre de menu), l’action de la touche Maj est inversée. La proportion entre hauteur 
et largeur sera automatiquement conservée, à moins que la touche Maj ne soit appuyée.

Avec la boîte de dialogue ou l’onglet Position et taille du volet latéral

Voir « Position et taille », page 11.

Modifier un arc

La taille d’un arc d’ellipse ou de cercle peut être modifiée en modifiant la position de ses points de 
départ et d’arrivée.

Sélectionnez l’arc et cliquez sur l’icône Points ( ) de la barre d’outils Standard. Deux poignées 
plus importantes apparaissent au début et à la fin de l’arc (Figure 7). Lorsque le curseur de la sou-
ris se trouve au-dessus de l’une de ces deux poignées, sa forme change et vous pouvez alors dé-
placer le point de départ ou d’arrivée de l’arc.

Figure 8 : Arc en cours de modification

Faire pivoter et incliner des objets

Pour faire effectuer une rotation à un objet (ou à un groupe d’objets), sélectionnez-le, puis passez 
en mode rotation par une des méthodes suivantes :

• cliquez une deuxième fois sur l’objet quand les poignées de sélection sont apparues (pas 
trop vite, ce n’est pas un double-clic),

• cliquez sur le triangle à droite de l’icône Transformations dans la barre d’outils Ligne et 
remplissage (ou la barre d’outils Standard) puis sur l’icône Pivoter ( ) dans la palette d’ou-
tils. L’icône de la palette d’outils Transformations est celle du dernier outil utilisé (  à l’ou-
verture de Draw),

La palette d’outils est détachable et devient la barre d’outils Transformations, que vous pou-
vez aussi afficher en sélectionnant Affichage > Barres d’outils > Transformations dans la 
barre de menu,
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• sélectionnez Pivoter dans le menu Forme > Transformation de la barre de menu ou dans 
le sous-menu Pivoter ou retourner du menu contextuel de l’objet.

Figure 9 : Un objet prêt à effectuer une rotation

Les poignées de sélection changent de forme et de couleur (Figure 9). Le centre de rotation appa-
raît également au milieu de l’objet. Déplacez le curseur de la souris au-dessus d’une des poi-
gnées : sa forme change. Les poignées de coin servent à faire effectuer une rotation à l’objet, tan-
dis que les poignées de côté servent à l’incliner.

Effectuer une rotation

Avec la souris

Le centre de rotation est normalement situé au centre du rectangle de sélection de l’objet. Pour le 
déplacer, cliquez sur celui-ci et tirez-le à la position voulue avec la souris ; celle-ci peut se trouver 
hors de l’objet.

Déplacez le curseur de la souris au-dessus d’une des poignées de coin. Le curseur prend norma-
lement la forme d’un arc. Cliquez et faites glisser pour faire tourner l’objet. Au fur et à mesure de la
rotation, une image fantôme du nouvel objet apparaît pour vous aider.

Vous trouverez également des informations dans la barre d’état, comme le montre la Figure 10. La
zone d’information vous indique que vous faites tourner un objet et l’angle de rotation. Les 
nombres indiquant la position et la taille s’actualisent au cours de la rotation.

Figure 10 : Objet en cours de rotation
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Remarque

Si vous gardez appuyée la touche Maj durant la rotation d’un objet, l’angle de rotation est li-
mité aux multiples de 15 degrés. Ceci est le comportement par défaut de la touche Maj. Ce-
pendant, si l’option Lors de la création ou du déplacement des objets de la section 
Contraindre les objets de Outils > Options > LibreOffice Draw > Grille est cochée, l’ac-
tion de la touche Maj est inversée. L’angle de rotation est limité aux multiples de 15 degrés 
(valeur par défaut), à moins que la touche Maj ne soit appuyée.

Remarque

La rotation des objets 3D fonctionne de manière assez différente, étant donné qu’elle s’ef-
fectue dans un espace à trois dimensions et non dans un plan simple. Voir Chapitre 7, Mani-
puler des objets 3D, pour plus d’informations.

Avec la boîte de dialogue ou l’onglet Position et taille du volet latéral

Voir « Rotation des objets », page 12.

Incliner des objets

Avec la souris

Pour incliner un objet (ou un groupe d’objets), sélectionnez-le, puis passez en mode rotation (voir 
« Faire pivoter et incliner des objets », page 7).

Déplacez le pointeur de la souris au-dessus d’une des poignées au milieu d’un côté. Il prend nor-
malement la forme de deux demi-flèches inversées. L’axe utilisé pour l’inclinaison est le côté oppo-
sé à celui de la poignée sur laquelle vous cliquez. Cet axe reste fixe, tandis que les autres côtés 
bougent en fonction du pointeur de la souris que vous faites glisser. Au fur et à mesure de l’inclinai-
son, une image fantôme du nouvel objet apparaît pour vous aider.

Vous trouverez également des informations dans la barre d’état, comme le montre la Figure 11. La 
zone d’information vous indique que vous inclinez un objet et l’angle d’inclinaison. Les nombres in-
diquant la position et la taille s’actualisent au cours de la rotation.

Figure 11 : Objet en cours d’inclinaison
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Remarque

Si vous gardez appuyée la touche Maj durant l’inclinaison d’un objet, l’angle d’inclinaison 
est limité aux multiples de 15 degrés. Ceci est le comportement par défaut de la touche Maj.
Cependant, si l’option Lors de la création ou du déplacement des objets de la section 
Contraindre les objets de Outils > Options > LibreOffice Draw > Grille est cochée, l’ac-
tion de la touche Maj est inversée. L’angle d’inclinaison est limité aux multiples de 15 de-
grés (valeur par défaut), à moins que la touche Maj ne soit appuyée.

Avec la boîte de dialogue ou l’onglet Position et taille du volet latéral

Voir « Inclinaison et rayon d’angle », page 13.

Définir la position, la taille ou les angles d’inclinaison et de rotation 
avec précision

Il est possible de positionner des objets ou de modifier leur taille avec la souris, mais cette mé-
thode est peu précise. Si vous voulez obtenir une position et une taille précises, vous devez utiliser
la boîte de dialogue Position et taille (Figure 12) ou la section Position et taille du volet latéral (Fi-
gure 13).

Figure 12 : L’onglet Position et taille de la boîte de dialogue Position et taille.

Pour ouvrir la boîte de dialogue Position et taille (Figure 12), sélectionnez l’objet, puis

• choisissez Position et taille dans le menu Format ou le menu contextuel de l’objet ;

• cliquez sur l’icône Position et taille ( ) à gauche de la barre d’outils Ligne et remplissage 
(Figure 1 en bas) ;

• appuyez sur la touche F4.
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Pour ouvrir la section Position et taille (Figure 13) du volet latéral, sélectionnez l’objet, puis cliquez 
sur l’icône Propriétés ( ) à droite du volet latéral puis sur la flèche ˅ à gauche du titre de la sec-
tion.

Figure 13 : Le panneau Position et taille de l’onglet Propriétés du volet latéral

Les options disponibles dans la boîte de dialogue et la section Position et taille du volet latéral sont
semblables. Elles sont cependant plus réduites dans ce dernier : on ne peut pas y protéger la posi-
tion et la taille de l’objet contre les dimensions, y définir le point de base pour les changements de 
position ou de taille ni permettre à l’objet de s’adapter au texte qu’il contient.

Position et taille

Position
– Position X : saisissez la distance horizontale entre le point de base sélectionné dans la 

grille et la marge gauche de la page.

– Position Y : saisissez la distance verticale entre le point de base sélectionné dans la grille 
et la marge du haut de la page.

– Point de base : sélectionnez un point de base dans la grille, puis saisissez, dans les 
champs Position Y et Position X, les coordonnées de ce point de base dans la zone impri-
mable de la feuille (l’origine étant, par défaut, l’intersection des marges gauche et supé-
rieure de la page). Les points de base correspondent aux poignées de sélection d’un ob-
jet.

Taille
Spécifiez les nouvelles dimensions de l’objet sélectionné. Le point de base restera fixe et les 
autres sommets seront déplacés en conséquence.

– Largeur : saisissez une largeur pour l’objet sélectionné.

– Hauteur : saisissez une hauteur pour l’objet sélectionné.

– Proportionnel : conserve les proportions ; lorsque vous modifiez une dimension de l’objet 
sélectionné, l’autre est calculée pour que leur rapport reste constant.

– Point de base : cliquez sur un point de base dans la grille, qui restera fixe, puis saisissez 
les nouvelles dimensions de l’objet sélectionné dans les champs Largeur et Hauteur.

Protéger
Ces options ne sont disponibles que dans la boîte de dialogue Position et taille.

Positionner et ajuster les objets | 11



– Position : cochez cette option pour empêcher les changements de position et de taille de 
l’objet sélectionné.

– Taille : cochez cette option pour empêcher les changements de taille de l’objet sélection-
né.

Adapter
Ces options spécifient si la taille de l’objet doit s’ajuster à celle du texte saisi. Elles ne sont 
disponibles que dans la boîte de dialogue Position et taille.

– Adapter la largeur au texte : cochez cette option pour étendre la largeur de l’objet à celle 
du texte si elle n’est pas suffisante.

– Adapter la hauteur au texte : cochez cette option pour étendre la hauteur de l’objet à celle 
du texte si elle n’est pas suffisante.

L’unité de mesure employée pour les coordonnées, la largeur et la hauteur est celle choisie dans 
Outils > Options > LibreOffice Draw > Général.

L’emplacement par défaut du point de base pour la position et la taille se situe dans le coin supé-
rieur gauche du rectangle de sélection de l’objet. Dans la boîte de dialogue Position et taille, vous 
pouvez changer temporairement de point de base en cliquant sur le point correspondant de la fi-
gure de droite. Ce changement n’est valable que pour une seule utilisation et le point de base re-
vient à son emplacement par défaut lors de la fermeture de la boîte de dialogue Position et taille 
(Figure 12, page 10).

Rotation des objets

Pour faire pivoter de façon précise un objet, utilisez l’onglet Rotation de la boîte de dialogue Posi-
tion et taille (Figure 14). Vous pouvez y définir l’angle de rotation et l’emplacement du centre de ro-
tation. Vous pouvez aussi utiliser les options disponibles dans la section Position et taille de l’on-
glet Propriétés du volet latéral (Figure 13, page 11).

Figure 14 : L’onglet Rotation de la boîte de dialogue Position et taille
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Point de pivot
L’objet sélectionné tourne autour d’un point de pivot (centre de rotation) dont vous précisez 
les coordonnées. Il est situé par défaut au centre du rectangle de sélection de l’objet. Si vous
placez le point de pivot loin hors des limites de l’objet, la rotation peut le déplacer hors de la 
page. Cette option n’est disponible que dans la boîte de dialogue Position et taille (Figure 
14).

– Position X : saisissez la distance horizontale entre la marge gauche de la page et le point 
de pivot.

– Position Y : saisissez la distance verticale entre la marge du haut de la page et le point de
pivot.

– Paramètres par défaut : sélectionnez une position pour le point de pivot parmi les neuf 
points proposés (les huit poignées et le centre du rectangle de sélection). Ce choix ne 
sera valable qu’une seule fois : le point sélectionné reprendra sa position par défaut au 
centre de la grille à l’ouverture suivante.

Angle de rotation
Spécifiez le nombre de degrés dont vous voulez faire tourner l’objet sélectionné (dans le 
sens inverse des aiguilles d’une montre).

– Angle : saisissez le nombre de degrés (entre 0° et 360°, 0° à trois heures) dont vous vou-
lez faire tourner l’objet ou utilisez les boutons pour augmenter ou diminuer la valeur indi-
quée (en nombres entiers). Cette option n’est disponible que dans la boîte de dialogue 
Position et taille (Figure 14).

– Paramètres par défaut : cliquez dans la roue et déplacez la souris sans relâcher le bouton
pour la faire tourner. Le nombre de degrés s’affiche dans le champ Angle (et réciproque-
ment : si vous modifiez le champ Angle, la roue tourne). Cette option n’est disponible que 
dans la boîte de dialogue Position et taille.

– Rotation : cliquez dans la roue et déplacez la souris sans relâcher le bouton pour la faire 
tourner. Le nombre de degrés s’affiche dans le champ de droite où vous pouvez aussi le 
saisir directement. Vous pouvez encore utiliser la liste déroulante de ce champ pour spé-
cifier un angle prédéfini. Cette option n’est disponible que dans la section Position et taille 
de l’onglet Propriétés du volet latéral (Figure 13).

– Retourner : retourner l’objet sélectionné verticalement ou horizontalement (symétrie 
axiale) en cliquant sur un des boutons. Cette option n’est disponible que dans la section 
Position et taille de l’onglet Propriétés du volet latéral.

Inclinaison et rayon d’angle

Pour paramétrer précisément le rayon d’angle ou l’angle d’inclinaison d’un objet, ouvrez l’onglet In-
clinaison et rayon d’angle de la boîte de dialogue Position et taille (Figure 15). Ces options ne sont 
disponibles que dans cet onglet.
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Figure 15 : L’onglet Inclinaison et rayon d’angle de la
boîte de dialogue Position et taille

Rayon d’angle
Il est seulement possible d’arrondir les sommets d’un objet rectangulaire. Si cette section est
grisée, le paramétrage d’un rayon d’angle n’est pas possible.

– Rayon : saisissez le rayon du cercle que vous voulez utiliser pour arrondir les angles. Plus
la valeur est grande, plus les sommets de l’objet sont arrondis.

Incliner
Permet d’incliner les bords verticaux de l’objet. Le résultat est différent d’une inclinaison avec
la souris, car la distance entre les bords horizontaux n’est pas modifiée.

– Angle : saisissez l’angle dont les bords verticaux vont tourner.

Point de contrôle 1 et 2
Saisissez les coordonnées des points de contrôles de l’objet par rapport au sommet supé-
rieur du rectangle de sélection de l’objet. En l’absence de point de contrôle, les champs sont 
grisés et vous ne pouvez pas y définir de coordonnées.

Utiliser la grille et les fonctions de capture

Avec Draw, vous pouvez positionner des objets de manière précise et cohérente en utilisant les 
points de la grille, les points et les lignes de capture, les cadres des objets, les points individuels 
des objets et les bords de page. Ce sont les fonctions de capture.

Il est plus facile d’utiliser les fonctions de capture avec un facteur de zoom le plus élevé possible 
pour votre document. Vous pouvez utiliser deux fonctions de capture en même temps ; par 
exemple, faire une capture à une ligne de guide et aux bords de page. Cependant, il est recom-
mandé de n’activer que les fonctions de capture dont vous avez réellement besoin.
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Configurer les fonctions de grille et de capture

Figure 16 : La page LibreOffice Draw – Grille de la boîte de dialogue Options

Pour configurer les fonctions de grille et de capture de votre document, sélectionnez Outils > Op-
tions dans la barre de menu puis ouvrez la page LibreOffice Draw – Grille (Figure 16). Les fonc-
tions de grille et de capture peuvent être affichées, activées et désactivées dans cette boîte de dia-
logue, en faisant un clic droit dans votre document et en utilisant les options du menu contextuel, 
ou en utilisant les icônes de barre d’outils Options (Figure 17). Si cette barre d’outils n’est pas affi-
chée, sélectionnez Affichage > Barre d’outils > Options dans la barre de menu.

Mode rotation après un clic 
sur l’objet

Afficher la grille Afficher les guides de capture

Lignes d’aide lors du dépla-
cement

Aligner sur la grille Capturer aux guides de capture

Capturer aux marges
Capturer à la bordure de
l’objet

Capturer aux points de l’objet

Permettre l’édition rapide
Sélectionner la zone de 
texte seule

Double-clic pour éditer du texte

Modifier l’objet avec des at-
tributs

Quitter tous les groupes

Figure 17 : La barre d’outils Options

Grille
Cette section définit les paramètres de la grille configurable qui peut être affichée sur les 
pages de votre document. Celle-ci vous aide à déterminer la position exacte des objets. 
Vous pouvez aussi relier cette grille à la grille magnétique. Si vous avez activé la grille ma-
gnétique, mais que vous voulez déplacer ou créer des objets sans attraction magnétique, 
maintenez la touche Maj appuyée pour désactiver cette fonction aussi longtemps que néces-
saire.
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– Capturer à la grille : spécifie si les cadres, éléments de dessin et contrôles sont unique-
ment déplacés entre points de la grille. Pour inverser l’attraction de la grille seulement 
pour l’action en cours, maintenez l’appui sur la touche Ctrl pendant que vous déplacez 
un objet. Cette option est aussi contrôlée par l’icône Aligner sur la grille ( ) de la barre 
d’outils Options.

– Grille visible : spécifie si la grille est visible ou non. Cette option est aussi contrôlée par 
l’icône Afficher la grille ( ) de la barre d’outils Options.

Résolution
– Horizontale : définit l’espacement horizontal entre les points principaux de la grille.

– Verticale : définit l’espacement vertical entre les points principaux de la grille.

– Synchroniser les axes : cochez cette option pour que les deux espacements et les deux 
nombres de subdivisions restent identiques quand l’un est modifié.

Subdivision
– Horizontale : définit le nombre d’intervalles entre deux points principaux de la grille dans 

le sens horizontal.

– Verticale : définit le nombre d’intervalles entre deux points principaux de la grille dans le 
sens vertical.

Capturer
– Aux lignes de captures : si cette option est cochée, la bordure de l’objet en cours de dé-

placement est attirée vers la ligne de capture la plus proche quand vous relâchez le bou-
ton de la souris. Cette option est aussi contrôlée par l’icône Capturer aux guides de cap-
ture ( ) de la barre d’outils Options.

– Aux marges de la page : si cette option est cochée, le contour de l’objet de dessin est ali-
gné sur la marge de la page la plus proche. Le curseur, ou une ligne du contour de l’objet,
doit être dans la plage de capture. Cette option est aussi contrôlée par l’icône Capturer 
aux marges ( ) de la barre d’outils Options.

– Au cadre de l’objet : si cette option est cochée, le contour de l’objet de dessin est aligné 
sur la bordure de l’objet de dessin le plus proche. Le curseur, ou une ligne du contour de 
l’objet, doit être dans la plage de capture. Cette option est aussi contrôlée par l’icône Cap-
turer à la bordure de l’objet ( ) de la barre d’outils Options.

– Aux points de l’objet : si cette option est cochée, le contour de l’objet de dessin est aligné 
sur les points de l’objet de dessin le plus proche. Le curseur, ou une ligne du contour de 
l’objet, doit être dans la plage de capture. Cette option est aussi contrôlée par l’icône Cap-
turer aux points de l’objet ( ) de la barre d’outils Options.

– Plage de capture : cette option définit la distance entre le pointeur de la souris et le 
contour de l’objet. Il est attiré par un point magnétique si le pointeur de la souris est plus 
proche que la distance choisie.

Contraindre les objets
– Lors de la création ou du déplacement des objets : si cette option est cochée, la création 

et le déplacement des objets de dessin est limitée à l’horizontale, la verticale et la diago-
nale (45°). Cette fonction peut être temporairement désactivée en appuyant sur la touche 
Maj.
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– Étendre les arêtes : si cette option est cochée, un carré est créé à partir du plus long côté 
du rectangle quand on appuie sur Maj avant de relâcher le bouton de la souris. De même,
un cercle sera créé à partir de l’axe le plus long de l’ellipse dans les mêmes conditions. Si
elle n’est pas cochée, le plus petit côté ou le plus petit axe sera utilisé.

– Lors de la rotation : cochez cette option pour la rotation des objets graphiques soit limitée 
à des multiples de l’angle précisé dans le champ voisin. Si vous voulez effectuer une rota-
tion à un angle autre que celui-ci, appuyez sur la touche Maj pendant la rotation. Relâ-
chez la touche quand l’angle désiré est obtenu.

– Réduction de point : définit l’angle pour la réduction de point. Quand vous travaillez avec 
des polygones, vous trouverez peut-être utile de réduire leurs points d’édition.

Capturer à la grille

Utiliser la capture par la grille

Utilisez la fonction de capture à la grille pour positionner un objet exactement à un point de la grille
de votre document. Cette fonction peut être activée et désactivée de plusieurs façons :

• Cochez l’option Capturer à la grille de la page LibreOffice Draw – Grille de la boîte de dia-
logue Options.

• Sélectionnez Affichage > Guides de capture > Aligner sur la grille dans la barre de menu.

• Faites un clic droit dans un espace libre de votre document et choisissez Guides de capture
> Aligner sur la grille dans le menu contextuel.

• Utilisez l’icône Aligner sur la grille  de la barre d’outils Options.

Afficher la grille

Vous pouvez activer ou désactiver l’affichage de la grille de plusieurs façons :

• Utilisez l’option Grille visible de la page LibreOffice Draw – Grille de la boîte de dialogue Op-
tions.

• Sélectionnez Affichage > Grille et lignes guide > Afficher la grille dans la barre de menu.

• Faites un clic droit dans un espace libre de votre document et choisissez Grille et lignes 
guide > Afficher la grille dans le menu contextuel.

• Utilisez l’icône Afficher la grille  de la barre d’outils Options.

Changer la couleur des points de la grille

Par défaut et selon les paramètres d’affichage de votre ordinateur, les points de la grille sont en 
gris et ne sont pas toujours très visibles. Vous pouvez sélectionner Outils > Options dans la barre
de menu puis ouvrir la page LibreOffice  – Couleurs de l’interface (Figure 18) et, dans la section 
Dessin/Présentation, sélectionner, dans la palette qui s’ouvre en cliquant sur le bouton, une cou-
leur plus appropriée pour les points de la grille.
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Figure 18 : La page Couleurs de l’application dans la boîte de dialogue Options

Lignes et points de capture

Contrairement à la grille, les lignes et les points de capture sont insérés par vous où vous souhai-
tez positionner un objet dans votre document. Les lignes de capture peuvent être horizontales ou 
verticales et apparaissent sous la forme de tirets. Les points de capture apparaissent sous la 
forme d’une croix de lignes de tirets. Les lignes et les points de capture n’apparaissent pas lors de 
l’impression du document.

Insérer des lignes et des points de capture

Pour insérer une ligne ou un point de capture, sélectionnez Insertion > Guide de capture dans la 
barre de menu. La boîte de dialogue Nouvel objet de capture s’ouvre (Figure 19).

Figure 19 : la boîte de dialogue Nouvel objet de capture

Position
Définit la position de la ligne ou du point de capture par rapport au coin supérieur gauche de 
la zone imprimable de la page.

– X : saisissez la distance entre la ligne ou le point de capture et la marge gauche de la 
page.
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– Y : saisissez la distance entre la ligne ou le point de capture et la marge supérieure de la 
page.

Type
Spécifie le type d’objet de capture à insérer.

– Point : insère un point de capture.

– Vertical : insère une ligne de capture verticale.

– Horizontal : insère une ligne de capture horizontale.

Conseil

Pour insérer une ligne de capture, vous pouvez tirer avec la souris la règle horizontale ou 
verticale jusqu’à la position voulue.

Afficher les lignes et points de capture

Vous pouvez activer et désactiver l’affichage des lignes et des points de capture de plusieurs fa-
çons :

• Sélectionnez Affichage > Guides de capture > Afficher les guides de capture dans la 
barre de menu.

• Faites un clic droit dans un espace vide de votre document et choisissez Guides de capture
> Afficher les guides de capture dans le menu contextuel.

• Utilisez l’icône Afficher les guides de capture  de la barre d’outils Options.

Vous pouvez activer ou désactiver l’affichage des lignes de capture au premier plan (devant les 
objets) de plusieurs façons :

• Sélectionnez Affichage > Guides de capture > Guides de capture au premier plan dans 
la barre de menu.

• Faites un clic droit dans un espace vide de votre document et choisissez Guides de capture
> Guides de capture au premier plan dans le menu contextuel.

Éditer les lignes et points de capture

Pour éditer une ligne ou un point de capture, positionnez-vous au-dessus de l’objet de capture et 
faites un clic droit, puis choisissez Éditer la ligne de capture ou Éditer le point de capture dans 
le menu contextuel pour ouvrir la boîte de dialogue Édition de la ligne / du point de capture (Figure 
20). Saisissez les nouvelles coordonnées du point, la nouvelle abscisse pour une ligne verticale et 
la nouvelle ordonnée pour une ligne horizontale. Vous pouvez également cliquer sur l’objet et le 
faire glisser à l’endroit voulu.

   
Figure 20 : Les boîtes de dialogue Édition de la ligne / du point de capture
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Supprimer des lignes et points de capture

Pour supprimer une ligne ou un point de capture, positionnez-vous au-dessus de l’objet de capture
et faites un clic droit, puis choisissez Supprimer la ligne de capture ou Supprimer le point de 
capture dans le menu contextuel.

Vous pouvez également cliquer sur l’objet de capture et le tirez sur une règle.

Configurer la plage de capture

Pour configurer la plage de capture à partir de laquelle un objet est attiré,

 1) Sélectionnez Outils > Options dans la barre de menu et ouvrez la page LibreOffice Draw – 
Grille (Figure 16, page 15).

 2) Dans le champ Plage de capture, saisissez le nombre de pixels pour définir la distance à 
partir de laquelle l’objet sera capturé. La valeur par défaut est 5 pixels.

 3) Cliquez sur OK pour définir la plage de capture et refermer la boîte de dialogue.

Utiliser les lignes d’aide

Les lignes d’aide lors du déplacement sont une autre fonction de Draw qui vous assiste pour posi-
tionner des objets. Des lignes d’aide peuvent être affichées au cours du déplacement d’un objet. 
Elles étendent les bords du rectangle de sélection de l’objet jusqu’aux règles (Figure 21), et n’ont 
aucune fonction de capture.

Figure 21 : Lignes d’aide lors du déplacement

Pour activer et désactiver l’affichage des lignes d’aide :

• Cochez l’option Lignes d’aide lors du déplacement de la page LibreOffice Draw – Affichage 
de la boîte de dialogue Options (Figure 22).

Figure 22 : La page LibreOffice Draw – Affichage de la boîte de dialogue Options
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• Utilisez l’icône Lignes d’aide lors du déplacement  de la barre d’outils Options ou Ligne 
et remplissage.

Modifier les formes géométriques simples

Lorsque vous dessinez ou sélectionnez certaines formes géométriques, un ou plusieurs points ap-
paraissent et ont une forme ou une couleur différente des poignées de sélection (Figure 23). 
Lorsque le curseur de la souris se trouve au-dessus de ces points, sa forme change. Si alors vous 
cliquez et faites glisser le curseur, la forme de l’objet change. Vous pouvez par exemple augmenter
le rayon d’angle d’un rectangle aux coins arrondis, ou changer l’épaisseur d’un cadre.

Figure 23 : Point de réglage d’un rectangle arrondi

Ces repères ont différentes fonctions selon la forme géométrique sélectionnée. Ces fonctions sont 
indiquées ci-dessous.

Formes de base

• Rectangle et carré arrondis : utilisez le point pour modifier le rayon d’angle de la courbe qui 
remplace les coins du rectangle ou du carré.

• Secteur de cercle : utilisez les points pour modifier la taille du secteur rempli.

• Triangle isocèle : utilisez le point pour modifier le type de triangle.

• Trapèze, parallélogramme, hexagone et octogone : utilisez le point pour modifier l’angle 
entre les côtés.

• Croix : utilisez le point pour modifier l’épaisseur des quatre bras de la croix.

• Anneau : utilisez le point pour modifier le diamètre intérieur de l’anneau.

• Arc plein : utilisez le point pour modifier à la fois le diamètre intérieur et la taille d’un arc 
plein.

• Cylindre et cube : utilisez le point pour modifier la perspective.

• Coin replié : utilisez le point pour modifier la taille du coin replié.

• Cadre : utilisez le point pour modifier l’épaisseur du cadre.

Formes des symboles

• Frimousse : utilisez le point pour modifier le sourire du visage.
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• Soleil : utilisez le point pour modifier le diamètre du cercle intérieur.

• Lune : utilisez le point pour modifier l’épaisseur de la lune.

• Cœur : utilisez le point pour modifier la forme du cœur.

• Interdit : utilisez le point pour modifier l’épaisseur de la barre diagonale et de l’anneau.

• Parenthèses, parenthèse ouvrante et parenthèse fermante : utilisez le point pour modifier la 
courbure des parenthèses.

• Accolades : utilisez le point pour modifier la courbure des accolades.

• Accolade ouvrante et accolade fermante ; utilisez les points pour modifier la courbure et la 
hauteur de la pointe de l’accolade.

• Plaque carrée, plaque octogone et plaque en forme de losange : utilisez le point pour modi-
fier de la forme intérieure de la plaque.

Flèches pleines

• Flèches : utilisez le point pour modifier l’épaisseur et la forme de la flèche.

• Pentagone et chevron : utilisez le point pour modifier l’angle entre les côtés.

• Légendes avec flèches : utilisez les points pour modifier la taille de la légende, la taille du 
trait et la forme de la flèche.

• Flèche en arc : utilisez le point pour modifier la taille de l’arc.

Légendes

• Légendes : utilisez le point pour modifier le pointeur.

• Légendes 1, 2 et 3 : utilisez les points pour modifier le trait pointeur.

Étoiles

• Étoile à 4 branches, étoile à 8 branches et étoile à 24 branches : utilisez le point pour modi-
fier la forme et l’épaisseur des branches.

• Parchemin horizontal et vertical : utilisez le point pour modifier la taille de l’enroulement du 
parchemin.

• Plaque de porte : utilisez le point pour modifier la courbure des coins incurvés de la plaque.

Courbes et polygones

Courbes de Bézier

L’édition des courbes s’effectue à partir des théories mathématiques des courbes de Bézier, qui 
portent le nom de l’ingénieur qui les modélisa dans les années 1960 dans le but de faciliter la mo-
délisation de la carrosserie des véhicules. L’explication des courbes de Bézier dépasse le cadre de
ce guide et seules les notions de base sont abordées ici.

LibreOffice manipule des courbes de Bézier de type cubique. Une telle courbe est définie par un 
point de départ P0, un point d’arrivée P3 et deux points de contrôle P1 et P2 (Figure 24). La 
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courbe commence au point P0 en direction du point P1 et se termine au point P3 depuis la direc-
tion du point P2. Plus le point de contrôle sera éloigné du point de départ ou d’arrivée, plus la 
courbe sera accentuée à cet endroit. Si un point de contrôle coïncide avec son point de départ ou 
d’arrivée, il n’aura aucune influence sur la courbe. Des tangentes apparaissent, reliant un point de 
contrôle à son point associé.

Figure 24 : Les points de contrôle d’une courbe de Bézier

L’édition d’une courbe de Bézier consiste à déplacer ses points de contrôle ou ses extrémités. 
L’angle relatif et la distance avec ces points de contrôle vont déterminer la forme de la courbe. 
Vous pouvez convertir un objet en un ensemble de courbes reliées entre elles. Des tangentes vont
se former, comportant un point de contrôle à chacune de ses extrémités et un point de jonction à 
l’endroit où elle rencontre la courbe. La Figure 25 vous montre ce qui se passe à partir d’un carré 
(transformé en courbe) en déplaçant un point de contrôle d’un sommet.

Figure 25 : Déplacer les tangentes pour créer des formes différentes

Vous pouvez créer différentes formes en déplaçant l’un des points de contrôle à l’extrémité d’une 
tangente, ou les deux points de contrôle, ou même le point de jonction avec la courbe. Draw offre 
encore plus de possibilités avec les fonctions de la barre d’outils Éditer les points.

Convertir en courbe ou en polygone

Avant d’éditer les points d’un objet, vous devez le convertir en courbe ou en polygone, selon le 
type d’effet que vous voulez produire. Après avoir sélectionné un objet,

• sélectionnez Forme > Convertir et choisissez En courbe ou En polygone,

• faites un clic droit et choisissez Convertir > En courbe ou Convertir > En polygone dans 
le menu contextuel.

Après avoir converti un objet en courbe ou en polygone, sélectionnez-le puis procédez d’une des 
façons suivantes pour éditer les points de l’objet

• cliquez sur l’icône Points  de la barre d’outils Standard,
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• choisissez Édition > Points dans la barre de menus,

• faites un clic droit sur l’objet et sélectionnez Points dans le menu contextuel,

• appuyez sur la touche F8.

La barre d’outils Éditer les points s’ouvre (Figure 26).

Notez que lorsque vous êtes en mode Édition de points, les poignées de sélection disparaissent et
font place à d’autres poignées de forme ou de couleur différentes. Ceci est normal, et ces nou-
velles poignées sont celles que vous allez utiliser avec les outils de la barre d’outils Éditer les 
points.

Barre d’outils Éditer les points

Éditer les points Déplacer des points Insérer des points

Supprimer des points Convertir en courbe Fermer la courbe de Bézier

Scinder la courbe Point d’inflexion Jonction lisse

Jonction symétrique Réduire les points

Figure 26 : La barre d’outils Éditer les points

Après avoir été ouverte, la barre d’outils Éditer les points (Figure 26) apparaît lorsque vous sélec-
tionnez un objet qui a été converti en courbe ou en polygone. Chaque fois que l’objet perd la sélec-
tion, la barre d’outils se ferme. La disponibilité des outils de cette barre d’outils dépend de l’objet et
du point de l’objet sélectionnés.

Actions sur les tangentes

Avant de pouvoir utiliser les tangentes sur un objet, vous devez le convertir en courbe. Sélection-
nez Convertir > En courbe dans le menu Forme ou dans le menu contextuel de l’objet.

Remarque

Les tangentes ne sont utilisées qu’avec les courbes. Si un objet a été converti en polygone 
et qu’un point d’inflexion est ajouté, ce qui crée deux tangentes, l’objet est automatiquement 
converti en courbe.

Jonction symétrique

L’outil Jonction symétrique  convertit un point anguleux ou une jonction lisse en point de jonc-
tion symétrique. Le point de jonction et ses points de contrôle sont alignés et séparés par des dis-
tances égales ; chaque mouvement d’un point de contrôle est transposé de façon symétrique à 
l’autre point de contrôle. Le rayon de courbure est le même dans les deux directions.

 1) Convertissez l’objet en courbe et cliquez sur le point de la courbe que vous voulez transfor-
mer en jonction symétrique.

 2) Cliquez sur l’icône Jonction symétrique  dans la barre d’outils Éditer les points (Figure 
26).
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 3) Cliquez sur une des poignées de la tangente et tirez-la pour modifier la forme de l’objet. Les 
deux poignées restent symétriques par rapport au point de la courbe.

Figure 27 : Point transformé en jonction symétrique

Jonction lisse

L’outil Jonction Lisse  convertit un point anguleux ou une jonction symétrique en point de jonc-
tion lisse asymétrique. Le point de jonction et ses points de contrôle sont alignés. Les deux points 
de contrôle se déplacent simultanément, mais peuvent être séparés par des distances différentes. 
La tangente devient asymétrique et la courbe est plus aplatie du côté le plus long et le rayon de 
courbure plus grand.

 1) Convertissez l’objet en courbe et cliquez sur le point de la courbe que vous voulez transfor-
mer en jonction lisse.

 2) Cliquez sur l’icône Jonction lisse  dans la barre d’outils Éditer les points (Figure 26, page
24).

 3) Cliquez sur une des poignées de la tangente et tirez-la pour modifier la forme de l’objet. Les 
deux poignées restent alignées avec le point de la courbe.

Figure 28 : Point transformé en jonction lisse

Point d’inflexion

L’outil Point d’inflexion  convertit le ou les points sélectionnés en points anguleux. Il est pos-
sible de modifier indépendamment l’angle de chaque côté de la tangente en déplaçant de façon in-
dépendante les deux points de contrôle.

 1) Convertissez l’objet en courbe et cliquez sur le point de la courbe que vous voulez transfor-
mer en point d’inflexion.

 2) Cliquez sur l’icône Point d’inflexion  dans la barre d’outils Éditer les points (Figure 26, 
page 24).
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 3) Cliquez sur une des poignées de la tangente et tirez-la pour modifier la forme de l’objet. 
Chaque poignée peut être déplacée indépendamment de l’autre pour créer des creux et des 
bosses dans l’objet.

Figure 29 : Point transformé en point d’inflexion

Rotation d’une jonction

Vous pouvez modifier l’angle que forme la tangente à un point de jonction par rapport à la courbe 
en déplaçant un des points de contrôle. La courbe va alors se déformer.

Figure 30 : Rotation de la tangente

Actions sur les points

Déplacer des points

Cliquez sur l’icône Déplacer des points  pour pouvoir déplacer chacun des points d’un objet 
converti en courbe ou en polygone. Quand l’icône est active, le curseur de la souris change de 
forme lorsqu’il se trouve au-dessus d’un point. Cliquez alors et faites glisser le curseur jusqu’à la 
position désirée.  La courbe de chaque côté du point suit le mouvement et la section de la courbe 
entre les deux points qui entourent le point déplacé change de forme.

Pour déplacer une forme entière sans la déformer, cliquez entre deux points ou à l’intérieur d’une 
courbe fermée et tirez-la avec la souris.

 1) Assurez-vous que l’objet est converti en courbe.

 2) Cliquez sur l’icône Déplacer des points  dans la barre d’outils Éditer les points (Figure 
26, page 24).

 3) Placez le pointeur de la souris au-dessus du point à déplacer. Quand le pointeur change de 
forme, cliquez et tirez le point pour créer une nouvelle forme comme sur la Figure 31.
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Figure 31 : Déplacer des points

Insérer des points

Cliquez sur l’icône Insérer des points  pour ajouter un point supplémentaire à une courbe ou à 
un polygone. Cliquez sur la bordure de l’objet, puis déplacez le curseur à l’endroit où vous voulez 
insérer un point. La jonction est lisse (le point inséré et ses deux points de contrôle sont alignés) si 
le point est inséré dans une courbe. Si vous souhaitez créer un point d’inflexion, créez le nouveau 
point puis convertissez-le grâce à l’outil Point d’inflexion (  à droite de la barre d’outils)

 1) Assurez-vous que l’objet est converti en courbe ou en polygone.

 2) Cliquez sur l’icône Insérer des points  à gauche de la barre d’outils Éditer les points (Fi-
gure 26, page 24).

Figure 32 : Insérer d’un point
dans une courbe (à gauche) dans un polygone (à droite)

 3) Cliquez sur la bordure de l’objet à l’endroit où vous voulez insérer le point. L’espacement des
points de contrôles dépend de l’endroit où le nouveau point a été ajouté. La Figure 32 
montre un nouveau point ajouté sur le côté droit d’un carré transformé en courbe puis dépla-
cé pour créer la forme illustrée.

Supprimer des points

Sélectionnez un ou plusieurs points et cliquez sur l’icône Supprimer des points  pour suppri-
mer le ou les points de la bordure de l’objet. Pour sélectionner plusieurs points, maintenez l’appui 
sur la touche Maj en cliquant sur ceux-ci. La courbe se transforme alors en fonction des points 
restants. Vous pouvez également supprimer un point sélectionné en appuyant sur la touche 
Suppr.

La Figure 33 montre ce qui se passe si vous supprimez trois points à gauche d’un cercle converti 
en courbe. L’image de droite est le résultat converti en ligne (voir « Convertir en courbe ou en 
ligne », page 28) : on obtient une ligne droite entre les deux points de chaque côté des points sup-
primés.
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Figure 33 : Supprimer des points
résultat (à gauche) après conversion en ligne (à droite)

Éliminer des points

L’icône Réduire les points (  à droite de la barre d’outils) ne fonctionne que sur des lignes avec 
plusieurs points. Celles-ci sont créées quand une courbe est convertie en ligne grâce à l’icône 
Convertir en courbe ( ) de la barre d’outils Éditer les points (Figure 26, page 24).

Pour supprimer un point et relier ses voisins par un segment, procédez de la façon suivante :

 1) Sélectionnez une courbe avec plusieurs points qui a été convertie en
ligne (voir « Convertir en courbe ou en ligne », page 28).

 2) Sélectionnez avec la souris le point de la ligne que vous voulez élimi-
ner. Ce point est mis en valeur.

 3) Cliquez sur l’icône Réduire les points( ) à droite de la barre d’outils Éditer les points (Fi-
gure 26, page 24).

 4) Placez le pointeur de la souris au-dessus du point sélectionné, cliquez
et commencez à le déplacer. Une ligne pointillée se forme entre ce
point et ses deux voisins.

 5) Quand la ligne pointillée est un segment qui joint les deux voisins, relâ-
chez le bouton de la souris. Le point sélectionné est supprimé et ses
deux voisins sont maintenant directement reliés par un segment.

Convertir en courbe ou en ligne

L’icône Convertir en courbe  va vous permettre de convertir une courbe en ligne droite, ou 
vice-versa. Quand une courbe est convertie en ligne un segment est créé entre les points sélec-
tionnés de la courbe. Quand une ligne est convertie en courbe, une courbe de Bézier est créée 
entre les points sélectionnés de la ligne.

 1) Sélectionnez une courbe (ou une ligne) puis les points de la courbe (ou de la ligne) auxquels
vous voulez appliquer la conversion.

 2) Cliquez sur l’icône Convertir en courbe  de la barre d’outils Éditer les points (Figure 26, 
page 24) pour convertir la courbe en ligne (ou la ligne en courbe).
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Figure 34 : Convertir une ligne en courbe

Si vous convertissez en courbe une ligne polygonale, les portions de ligne restent droites, mais 
des points de contrôle apparaissent. Déplacez-les pour obtenir une courbe à votre convenance.

Scinder les courbes

 1) Sélectionnez le point de la courbe où vous voulez effectuer une coupure. Pour séparer une 
courbe simultanément à plusieurs endroits, maintenez l’appui sur la touche Maj en sélection-
nant tous les points où la coupure doit se produire.

 2) Cliquez sur l’icône Scinder la courbe  de la barre d’outils Éditer les points (Figure 26, 
page 24) pour scinder ou couper la courbe à l’endroit du point sélectionné. Si l’objet est rem-
pli, le remplissage est supprimé, étant donné que la courbe qui constitue la bordure de l’objet
n’est plus fermée.

 3) Désélectionnez la courbe, puis cliquez et faites glisser le curseur de la souris pour éloigner le
segment coupé de la courbe (Figure 35).

Remarque

Le point où vous scindez la courbe est désormais plus grand que les autres points visibles 
sur la courbe, le point de départ mis à part.

Figure 35 : Courbe scindée en deux parties

Fermer les courbes

 1) Sélectionnez la courbe ouverte,

 2) Sélectionnez un point de la courbe. Notez que le point de départ est plus grand que les 
autres points visibles sur la courbe.
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 3) Cliquez sur l’icône Fermer Bézier  de la barre d’outils Éditer les points (Figure 26, page
24) pour fermer la courbe par une ligne droite entre ses points d’arrivée et de départ (Figure 
36).

Si la courbe ouverte était à l’origine une courbe fermée et remplie, et si vous cliquez sur 
l’icône Fermer Bézier, la courbe sera alors fermée et remplie.

Figure 36 : Fermer une courbe

Faire pivoter et distordre les courbes

 1) Sélectionnez la courbe puis choisissez Affichage > Barre d’outils > Transformations dans
la barre de menu pour ouvrir la barre d’outils Transformations. Cliquez sur l’icône Pivoter (

 ; voir « Faire pivoter et incliner des objets », page 7 pour plus d’informations sur la ro-
tation des objets).

 2) Sélectionnez un des points de la courbe et tirez-le à une nouvelle position pour déformer la 
courbe (Figure 37).

 3) Sélectionnez un des points de contrôle au bout d’une tangente et faites tourner la courbe dé-
formée en faisant glisser le pointeur de la souris. La courbe tourne autour du centre de rota-
tion.

Figure 37 : Déformer et faire tourner une courbe
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